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About This Manual

This manual explains how to install and customize the Nways* 2220 Switch
Manager on a network management workstation.

About the Switch Manager
The Nways 2220 Switch Manager manages the IBM 2220 Nways Switches in a
Networking BroadBand Service (NBBS*) network.

Many models and types of RISC System/6000 may be used as network manage-
ment stations, and there is a wide range of possible software configurations for
them.

Not Included in this Manual
Not included in this manual are details of hardware and software that must be
installed as a prerequisite to installation of the NSM. In particular, this book does
not  include:

� Installation of the prerequisite hardware in the network management RISC
System/6000 station

� Installation of the prerequisite software, such as NetView for AIX or TMN 2.2

� Installation of a NetView client.

How this Manual is Organized
The manual is organized so that the tasks are in the same order as you would
perform them. This manual includes the following chapters, and appendixes:

� “Before You Begin” on page 1, describes all the hardware and software prereq-
uisites for the network management station and includes detailed information
about client/server environment.

� “Before Installing the NSM” on page 5, lists the tasks to perform on the
network management station before installing the NSM components.

� “Installing the NSM” on page 7, explains how to install the NSM software.

� “Customizing the NSM” on page 13, explains how to customize the network
management station for each NSM component.

� “Specific Considerations” on page 23, includes more information about installa-
tion and about NSM components.

� Appendix A, “NSM CD ROM Image” on page 25, lists all the software files
included in the NSM package.

� Appendix B, “Troubleshooting” on page 27, describes how to handle problems
that may arise while setting up or starting the network management station
running the NSM.

A glossary that includes a list of abbreviations and a bibliography are provided at
the end of this manual.
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 Prerequisite Knowledge
As a prerequisite to installing the NSM software you must be familiar with:

 � RISC System/6000*

� AIX* operating system

� NetView* for AIX client/server concepts

� Network administration procedures.

Where to Find More Information
For a complete list of the customer and service information manuals, refer to
“Bibliography” on page 45.

 Terminology
Throughout this manual, the Nways 2220 Switch Manager is referred to as NSM.
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Before You Begin

Before installing the NSM on your system:

� Determine the number of network management stations you need, according to
the size and characteristics of your network.

� Make sure that the hardware and software prerequisites described in this
chapter are met.

The NSM supports the client/server environment. If you wish to use it, see page 3
for detailed information.

Two manuals that provide supplementary information to the procedures described
in this installation guide are:

� 2220 Nways BroadBand Switch Planning Guide, GA33-0293-04

� NetView for AIX Installation and Configuration, SC31-8163.

You may find it helpful to have them at hand while reading through this manual.

Determining the Number of Stations You Need
There must be at least one network management station in your network.
Depending on the size and characteristics of your network or administrative organ-
ization, you may need to use more than one network management station.

The NSM software can be installed on several network management stations. You
must install at least one NSM server, and can install several clients.

The NSM manages a number of objects and each resource defined in an Nways
2220 Switch corresponds to one or more objects registered in the ovw database.
The 2220 Nways BroadBand Switch Planning Guide describes the number of
objects generated by each resource defined in an Nways 2220 Switch. This guide
also provides a table defining the RISC System/6000 station you need according to
the number of objects to be managed.

 Hardware Prerequisites
The 2220 Nways BroadBand Switch Planning Guide provides a table that defines
the required hardware configuration according to the resources managed and the
number of operators.

The minimum hardware configuration required for the server network management
station is a RISC System/6000 POWERstation* or POWERsystem with:

� A minimum 128 MB of RAM is needed to manage a small network (fewer than
3 nodes) but at least 256 MB is recommended. More RAM must be added as
the number of nodes to be managed is increased.

� Approximately 64 MB minimum of additional RAM is required for additional
operators, depending on the number of maps manipulated.

� Minimum disk space: 2 GB.
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� Additional disk space required: More than 1 GB for accounting file (used for
billing applications).

� Installation of a 10 MB Ethernet network adapter that is connected to one of the
Nways Switches.

Note:  Refer to the product installation documentation for detailed instructions on
how to install the preceding devices or adapters.

Your system must include a CD ROM drive in order to install the NSM software.

Each additional client runs on an additional RISC System/6000. For information on
how to configure a client, see the NetView for AIX Installation and Configuration
manual.

 Software Prerequisites
Table 1 displays the software platforms supported on your network management
station.

Note:  Although not a prerequisite, you should be using Netview V4.1, with PTF
V451880.

To use the web browser interface provided by the Nways Enterprise Manager, you
need Lotus Domino Go WebServer 4.6.1 on the server station. This is included in
the AIX 4.2 bonus pack, together with Netscape V3.1.

Compatibility:  The Nways 2220 Switch Manager (NSM) manages IBM 2220
Nways BroadBand Switches running Nways Switch Control Program Version 1
Release 5.0 (5622-388) or Version 2 Release 1.0 (5765-C71).

For the software prerequisites of each additional client  network management
station that runs on a separate RISC System/6000 workstation, refer to the NetView
for AIX Installation and Configuration manual, SC31–8163, or the TMN/6000
General Information manual, GT01–0458.

Table 1. Software Platforms Supported

IBM AIX Oper-
ating System:

Network Management Application

IBM TME 10** NetView for AIX
(5697-NVW)
with TME 10 Distributed Monitoring
(5697-EMN)

IBM TMN/6000

Version 2
Release 2

(5799-QLN)
Version 4
Release 1

Version 5

Version 4
Release 1
Level 5

YES YES NO

Version 4
Release 2
(and above)

YES YES YES
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 Client/Server Considerations
NSM applications support the client/server environment of NetView for AIX. NSM
distributes the graphical user interface and the processes (memory and CPU proc-
essing) to the client machines in the network.

NSM contains:

� Servers or daemons (hardware server, topology server, and so on).

Servers are background processes that run continuously to update information
on the objects in the ovw database that reflects the MIB (Management Informa-
tion Base) of the agent. They are responsible for discovery and receive CMIP
(Common Management Information Protocol) notifications from agents each
time there is a MIB update (attribute value change, status change, creation,
deletion).

� Clients or applications (hardware client, topology client, and so on).

Clients are foreground processes running only when the NetView for AIX end
user interface is running. They are responsible for:

– Building the graphical user interface in a given map.

– Dynamically updating the graphical user interface on server request.

– Implementing operator requests:

- For certain requests such as actions on an agent object (creation,
update, activation, and so on), the CMIP request is sent to the agent
and the client receives the CMIP response.

- For other operator requests (such as network refresh topology), the
client sends a message to the server, which executes the request.

If you plan to use the client-server features of NSM, use the same client-server
relationship that you use for the NetView for AIX workstations in your network. An
NSM client must be installed on a NetView client, and an NSM server on the
NetView server.

Note:  Do not install the server code on a client station, because:

� The ovw database resides on the server machine.

� The maps can be stored locally on client machines, or they can reside
on the server machine and the maps created on clients will be stored
through NFS on the server. You can configure a client to use local or
NFS mounted maps by selecting Configure → Add/Change Server
from the clients in the NetView for AIX SMIT screen. Refer to the
NetView for AIX documentation for more information.
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Before Installing the NSM

This chapter describes the tasks that you must perform before installing the NSM.

� If you install the NSM in a client-server environment, it is assumed that the
NetView for AIX server and clients are already installed and configured (refer to
the NetView for AIX Installation and Configuration manual SC31–8163).

� To schedule and perform installation and migration tasks, ask your IBM mar-
keting representative for the document 2220 Network Release 5, Installation
and Migration Guide.

Before installing the NSM for the NBBS network resources that you want to
manage, perform the appropriate tasks described in this chapter.

Removing Previous Release of NSM
Important:  It is not necessary to remove previously installed IBM Nways
Broadband Switch Manager software of the following releases: Release 4 (shipped
with NEM Release 1), Release 5 (shipped with NEM Release 2 and Release 6
(shipped with NEM 3.0).

If you have an IBM Nways Broadband Switch Manager Release 1, Release 2, or
Release 3 already installed , you must remove it before installing the new NSM
level.

Before removing the previous release of NSM, ask your IBM marketing represen-
tative to provide you with the document 2220 Version 2.2

 Network Installation and Migration that explains how to upgrade:

� Your network management station

� Change control server

� Nways Switch configurations.

To remove a downlevel of NSM, follow these steps:

1. Access the installation program by entering smit .

2. Select Software Installation & Maintenance .

3. Select Software Maintenance and Utilities .

4. Select Remove Installed Software . When the Remove Installed Software
dialog box is displayed, select one of the following software files and specify
No in the PREVIEW only entry field (otherwise the remove operation will not
occur).

� NBBS.base.obj  for a server network management station

� NBBS.Client.base.obj  for a client network management station.

5. Perform a Shutdown
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Checking and Setting Environment Variables
To check and set the environment variables defined in the /etc/environment file,
perform the following steps from the network management station console:

1. Log in as root

2. Edit the file /etc/environment

3. If the paths /usr/OV/bin and /usr/OV/bin/AHAQ are not already defined, add
them to the PATH: statement.

4. For example, if the statement is currently:

PATH=/usr/bin:/usr/OV/bin

modify it to:

PATH=/usr/bin:/usr/OV/bin:/usr/OV/bin/AHAQ

5. Save the file /etc/environment

6. Type shutdown -r and press Enter  to reboot the RISC System/6000.

This will save the new values as the defaults.
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Installing the NSM

This chapter describes how to install NSM on a network management station.

Note:  Throughout this chapter Network Management Station is referred to as the
NMS.

The IBM Nways 2220 Switch Manager is distributed on CD ROM.

Use the roadmap in Table 2 to quickly locate:

� Installation process to use

� List of software files to install on the appropriate network management station

� Checking procedure after installation.

Table 2. Roadmap For Installing NSM

To Install NSM on: For the
installation
procedure,
go to:

For the soft-
ware files to
install, go to:

For the
installation
checking pro-
cedure, go
to:

A Single
Network Man-
agement
Station

Combined
Client/Server

“Installing
NSM on a
Client/Server
NMS” on
page 8

Table 3 on
page 11

“Checking the
Installation” on

page 12

Separate
Network Man-
agement
Stations:

Server “Installing
NSM on a

Client/Server
NMS” on
page 8

Table 3 on
page 11

Client “Installing
NSM on a

Client NMS”
on page 10

Table 3 on
page 11

 Copyright IBM Corp. 1996, 1998  7



  
 

Installing NSM on a Client/Server NMS
This section describes the procedure to install the NSM using SMIT. SMIT has
facilities that provide menus and on-line help to guide you through the installation
procedure.

To install NSM on a client/server network management station  (NMS), follow
these steps:

1. Ensure that you have enough free disk space (see “Hardware Prerequisites” on
page 1.

2. Stop (exit) any existing version of NSM that may be running.

3. Insert the CD ROM.

4. Open an aixterm window.

5. Log in as root.

If NetView security services are running, you must turn them off in one of the
following ways:

� Log in as admin and set security off for the user root

� Ask your NetView administrator to set the security off.

6. Access the installation program by entering smit .

7. Select Software Installation & Maintenance .

8. Select Install and Update Software .

9. If you are using:

� AIX Version 4.1.5, do the following:

a. Select Install and Update Selectable Software (Custom Install) .

b. Select Install Software Products at Latest Level .

c. Select Install New Software Products at Latest Level .

The Install New Software Products at Latest Level dialog box is displayed.

� AIX Version 4.2 or above, select Install and Update from LATEST Avail-
able Software .

The Install and Update from LATEST Available Software dialog box is dis-
played.

10. Select the List  button next to the INPUT device / directory for software field. A
list of input devices is displayed. Select CD ROM drive  from the list and then
select OK.

Notes:

a. The input device you selected is displayed in the INPUT device / directory
for software entry field (for example /dev/cdð).

b. SMIT might not recognize the input device if you installed the device after
starting AIX on the station. To add the device to your configuration:

1) Return to the SMIT System Management menu.

 2) Select Devices .

3) Select Install / Configure Devices Added After IPL .

8 Nways 2220 Switch Manager: Installation Guide  



  
 

11. In the dialog box displayed, select the List  button next to the SOFTWARE to
install field.

The system then reads the CD ROM.

12. Select the appropriate software files listed in Table 3 on page 11:

13. Use the List  option to set the following values in the remaining entry fields:

PREVIEW only? (install operation will not occur) no

COMMIT software updates? yes

SAVE replaced files? no

ALTERNATE save directory? —

AUTOMATICALLY install requisite software? yes

EXTEND file systems if space needed? yes

OVERWRITE same or newer versions? no

VERIFY install and check file sizes? no

Include corresponding LANGUAGE filesets? yes

DETAILED output? no

14. Select OK to confirm and continue the installation.

The appropriate software files are loaded into the system.

15. When the installation is completed, select Done  to close :

� The Install New Software Products at Latest Level menu, for AIX Version
4.1.5

� The Install and Update from LATEST Available Software menu, for AIX
Version 4.2.

and then select Exit SMIT  from the Exit pull-down menu.

The SMIT window is closed and the NSM is now installed on your network man-
agement station.
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Installing NSM on a Client NMS
To install the NSM on a client network management station  (NMS), follow these
steps:

1. Refer to the NetView for AIX Installation and Configuration manual:

� Read the detailed instructions on how to install the NetView for AIX client
code, either remotely (from the server to the client) or locally (at the client).

Note:  If you install the client locally, you must:

a. Configure the server to give a client access.

b. Configure the client to access the server.

� Refer to “Using SMIT to install Client,” to install NSM on your client network
management station.

2. Select the software files listed in 11.

3. Refer to “Customizing the NSM” on page 13, and perform the tasks that are
necessary before running applications on your client network management
station.
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Files to Install on the NMS
To install NSM, select the software files listed in Table 3

Table 3. Files to Install on the Network Management Station

Configuration Software Files to Install

Single Client/Server NMS NBBSM.base.obj
and
NBBSM.tmnsf_rte.obj
only if your network management application is
 IBM TME 10 NetView for AIX

Server only NMS NBBSM.base.obj
and
NBBSM.tmnsf_rte.obj
only if your network management application is
 IBM TME 10 NetView for AIX

Client only NMS NBBSM.client.base.obj
and
NBBSM.client.tmnsf_rte.obj
only if your network management application is
 IBM TME 10 NetView for AIX

  Installing the NSM 11



  
 

 Checking the Installation
To verify that NSM has been properly installed, do the following from the network
management station:

� Using SMIT, check the installation of the NSM as follows:

1. Open an aixterm window.

2. Access the verification program by entering smit .

3. Select Problem Determination .

4. Select Verify Software Requisites and Installations .

The Verify Software Requisites and Installations dialog box is displayed.

5. In the SOFTWARE name field, enter the SOFTWARE file names to verify,
or click on the List... box and check that the relevant file is in the displayed
list. The possible entries are shown below:

SOFTWARE name Nways 2220 Switch Manager component

NBBSM.Client.base.obj NSM Client

NBBSM.Client.tmnsf_rte.obj NSM Client (TMN Runtime)

NBBSM.base.obj NSM Server+Client

NBBSM.tmnsf_rte.obj NSM Server+Client (TMN Runtime)

6. Press OK to complete the verification procedure.

7. When the status is OK, select Exit SMIT  from the Exit pull-down menu.
The SMIT window is closed.

� Look at the smit.log file for a listing of the installation steps, and check that no
installation errors have been logged.

During the installation of NSM, the installation and configuration steps are
logged in the smit.log file. This file is saved under the home directory
($HOME/smit.log) of the user who is performing the installation.
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Customizing the NSM

This chapter describes the procedures for customizing network management
stations after NSM has been installed and before applications are started.

Routing Table Considerations
The TCP/IP protocol in the network management station maintains routing tables
containing information about the path to every reachable destination in the NBBS
network. These tables are periodically refreshed by TCP/IP to dynamically take into
account the configuration changes in the network. The refresh period is automat-
ically set to one minute when installing NSM.

If your network management station is attached through a router to the manage-
ment access Nways Switch , you must set a refresh period of one minute in the
router. Refer to the appropriate router documentation to set the correct value for the
refresh period.

The default value for the AIX Address Resolution Protocol (ARP) timer before the
installation of NSM is 20 minutes. If you want to restore the default timer on your
network management station, type the following command in root mode:

no -o arpt_killc=2ð

Internet Connection Server Configuration
To use the web browser interface, provided by the Nways 2220 Switch Manager,
you must install Lotus Domino Go WebServer 4.6.1 on the server. See“Software
Prerequisites” on page 2. If the Internet Connection was installed before you
installed NSM, you do not need to configure it. If Lotus Domino Go WebServer has
not been installed, you must install and configure it as follows:

1. Install the Lotus Domino Go WebServer, by following the installation procedure
in the documentation that comes with the product.

2. Log in as root.

3. Type the following commands:

cd /usr/OV/install/AHAQ

configure_nsm_web_applications

To return to your previous configuration, use the following command:

cd /usr/OV/install/AHAQ

desinstall_nsm_web_applications
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Customizing the NSM
After you have installed the NSM, you need to customize the network management
station configuration files according to your network configuration.

Configuring TCP/IP Communication
You must define all IP addresses of the server and clients network management
stations that you have installed by using the Attached IP Host Configuration window
of the Nways Switch Configuration Tool Version 2 (NCT2).

For more information about using this NCT2 configuration window and how to con-
figure the IP addresses for the network management stations, refer to the on-line
help of the NCT2 window.

Defining the Nways Switches (ab_netdef.txt file)
You must define all the Nways Switches of the NBBS network managed by the
network management station by editing the following file:
/usr/OV/install/AHAQ/ab_netdef.txt

To avoid a long discovery process, you should only register in this file the Nways
Switches that are actually running in your network. Add new Nways Switches as
you set them up.

In a client-server environment, only one ab_netdef.txt file is defined on the server
station.

The format of this file is:

192.12.97.65        SomewhereNwaysSwitch.EtcIncNetwork.Worldwide.
192.12.97.67        OtherplaceNwaysSwitch.EtcIncNetwork.Worlwide.

Nways Switch
(NAS) IP Address Nways Switch Name

NBBS Network Name

Domain Name

where:

� Nways Switch IP address is defined for the NAS of this Nways Switch by the
NCT2 in the configuration.

� Nways Switch name and network name are defined in the configuration
according to your naming convention.

� Domain name is defined in your configuration.

Notes:

1. If you have several network management server stations in your NBBS
network, the /usr/OV/install/AHAQ/ab_netdef.txt file must be changed in
each of them.

2. A dot (.) is mandatory at the end of each record.

3. The default filename and directory of the ab_netdef.txt file can be changed by
editing the file /usr/OV/lrf/AHAQTS.lrf as described in the following section.
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Customizing Registration Files and Timers
This section lists the timer values in the registration file, and describes the proce-
dure to change them when the NSM is running.

Timer Values in Registration File
The Registration file on the server station is: /usr/OV/lrf/AHAQTS.lrf

You may customize NSM timers in this file. The timer values are in seconds, and
the default values are given in parentheses.

Important:  For the timers l, s, L, S, the following rule must be respected :

 l < s < L < S

-h (/usr/OV/install/AHAQ/ab_netdef.txt). Full name of the path for the
ab_netdef.txt file.

-L (1800). Delay between two liveness checks of all the discovered Nways
Switches.

-l (120). Delay in answering a liveness check message. Topology dis-
covery resumes if the Nways Switches do not answer on time.

-s (240). Time allowed for discovery of Nways Switches. Topology dis-
covery stops when this time has elapsed, even if all Nways Switches
have not yet been discovered. Increase the value when the number of
Nways Switches increases.

-S (3600). Delay between two topology discoveries. Topology discovery
resumes (after the delay) until all Nways Switches listed in
ab_netdef.txt have been discovered.

-T (86400). Delay between two clock-settings sent by the NSM to the
agents. Setting the -T parameter to -1 disables the sending of any
clock-settings by NSM. If you have several NSMs, only one of them
should set the clock, and the -T parameter will have to be set to -1 in all
the other NSMs. The default value is 86400 s (24 hours).

Changing Timer Values
If you want to change certain timer values when the NSM is running, follow these
steps:

1. Change the current directory to the directory where the file is located by speci-
fying :

/usr/OV/lrf

2. Edit the file containing the timer you want to change.

3. Change the timer value.

4. Save the file.

5. Type the command:

/usr/OV/bin/ovdelobj AHAQTS.lrf

Then press Enter .

6. Type the command:

/usr/OV/bin/ovaddobj AHAQTS.lrf
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Then press Enter .

7. Stop the daemon by typing:

/usr/OV/bin/ovstop AHAQTS

Then press Enter .

8. Restart the daemon by typing:

/usr/OV/bin/ovstart AHAQTS

Then press Enter .

The NSM takes into account the new timer value.

Definition of Management Information Package
The installation of the NSM component replaces the DMI (Definition of Management
Information) OM Package shipped with the NetView for AIX product.

If you have any other CMIP management applications which are using the DMI
package, you must  recompile these applications. Otherwise they will not run cor-
rectly.

Make sure that you include the new /usr/OV/include/omp_dmi.h file when you
recompile.

 Client-Server Environment
To correctly update topology and hardware when all your network management
stations are configured, NSM should operate in a read/write map. By default, the
default map is open.

A map can only be open in read/write mode by one user. Other users access it in
read only mode. This is true on the server across clients (for NFS-mounted maps),
and within clients (for multiple users on a single client). To put a map in read/write
mode on your station, you can do one of the following:

� Create a new map using File → New Map  from the main menu of NetView for
AIX.

� Use the -map option when starting NetView for AIX as follows:

nv6ððð -map myMap

This option creates a specific map when you start NetView for AIX. It is named
myMAP.

Netview Security Services

 Access Control
NSM software uses the security features provided by NetView for AIX.

The security features for the NSM applications are implemented as follows:

� Each application has a Security Registration File (SRF) controlling access to
resources such as Menubar menustrings, Context Menu menustrings, Tools
window items, and user command lines.

� Three groups of operators are defined :
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– grpbasic : operators of this group are allowed to manage all the logical and
physical resources.

- They can display their configuration, use actions like activate, deacti-
vate, lock, unlock.

- They are authorized to do connection monitoring and to use the Per-
formance application.

- They can use Event Desk, MIB Browser, and Event Filter Editor
(TMN6000).

- They are not allowed  to modify the existing configuration (using
modify, create or delete) or to ask for a NAS re-IPL.

- They cannot use  the Accounting application.

– grpconf : same definition as grpbasic group of operators with authorization
to modify the configuration and to ask for NAS re-IPL.

– grpacct : same definition as grpbasic group of operators with authorization
to use the Accounting application.

� Three operator profiles are also available:

– opbasic  belonging to the grpbasic group.

– opconf  belonging to the grpconf group.

– opacct  belonging to the grpacct group.

The security administrator can add, modify, or delete the groups and profiles using
the security functions of NetView (/usr/OV/bin/nvsec_admin command).

The groups delivered with NSM can be used as examples by administrators to
define new groups according to their needs.

It is recommended that you add new groups instead of modifying the default NSM
groups, because when you upgrade the software, the user-defined Security Regis-
tration Files (SRF) can easily be saved and restored.

You must customize each SRF for all the groups that are actually used by the
security  on your system. Use the nvsec_admin command to update the SRF for
each application.

 Audit Log
 

The Audit Trail feature implemented in the NSM uses the audit functions of
NetView for AIX. Operations of the network management process are recorded in
audit logs.

The audit logs are managed by the NetView for AIX audit process. Network activ-
ities are logged once the audit options of Netview have been configured and acti-
vated.

To configure the audit options, enter the command /usr/OV/bin/nvsec_admin to go
to the main Security Administration panel and select Options →Global Settings
from the menu bar to open the Global Setting panel. By default, the 3 categories of
audit files are activated.
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The audit logs are ASCII flat files. You can easily look at the contents of these files
using standard editors and utilities. Alternatively, you can use the Netview reporting
facility by selecting Options →Audit Report  from the menu bar of the Netview
Security Administration panel. Then select File→Open  from the Netview Security
Audit panel to select an audit log from the list. The default is:

/usr/OV/log/sec_audit_log

The Audit Trail feature of NSM logs configuration and monitoring commands such
as:

� Display, create, modify, delete any object in the network.

� Activate, deactivate, lock, unlock any trunk, adapter, LIC or line.

� IPL the node.

� Perform TCPIP function for a node.

� Refresh or reset topology of a node/network.

� Start or stop performance monitoring for a resource.

� Handle accounting commands.

Note that no information is logged when displaying:

� A specific hardware submap

� A list of resources (ATM, X.25)

� General X.25 parameters

� CMIP status of a resource.

For each user request, an audit trail record is created in the audit log. If a user
request generates two CMIP requests, two audit records are created in the audit
log.

The audit log consists of audit records. Each audit record contains the following
information:

 � Time stamp

 � User name

 � Machine identifier

 � Application identifier

 � Request type

 � Resource identifier

� Result of operation.

The time stamp , user name , and machine identifier  are standard information
generated by the Netview audit trail process.

The application identifier  corresponds to the application that is running. This iden-
tifier is the name of the software module followed by the type of the application. For
example: AHAQH - HARDWARE or AHAQT - TOPOLOGY.

The request type  is the operation that has been requested.
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The resource identifier  is:

� For a hardware application, the Distinguish Name (DN) without the Object Infor-
mation (OI). For example, for a line, the identifier is:

network.node.rack.adapter.LIC.slot[.LCB].line

You can display the Distinguish Name of a resource by using the
TOOLS→display Object information  option from the NSM application menu
bar, on the root submap of NetView for AIX.

� For a software application, the sequence of elements describing the related
object. For example, for an X.25 subscriber, the identifier is:

Subscriber :xxx, X.25 Network Interface :yyy, node :zzz

The result of operation  is the result of the request. It can be:

� OK when the request ends normally.

� An error message, when an error occurred during processing of the request.

� TIME OUT, when no response is received from the agent.
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Accessing the Readme Files
Once you have installed NSM, and before starting  any application, do not forget to
read the readme  file which contains important information about using the product,
and describes any known problems. The readme file is located in
/usr/lpp/NBBSM/readme
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Waiting for Topology Discovery
The clear NSM topology feature was implemented to prevent complete ovw data-
base cleanup during the installation of the NSM. This feature allows you to install
the NSM while keeping other information related to other products in the ovw data-
base.

During installation, a program is run to find and mark as deleted all objects that are
related to NSM. These objects are in fact deleted when the end-user interface is
started.

After installation, during program start-up, there is a phase of synchronization
where the NSM icons remain displayed in the screen. Please wait for the com-
plete start up  of the product (about 2 minutes). Start-up is completed when the
dialog box informing you that there is no NBBS network available is displayed.

If you are running in a client-server environment, only the default map of NetView
will have been updated by the clear NSM topology feature. If you have created a
read/write map on a client, you should delete it using File → Delete Map , then
create a new map using File → New Map  to get an updated map on the client
station.

Note:  Inconsistencies such as duplicate hardware objects may appear if you do
not create a new map in the environment described above.

Starting the Nways 2220 Switch Manager
To start NSM, perform the following steps from the network management station:

1. In an aixterm window, type:

cd /usr/OV/install/AHAQ

Then press Enter .

2. Depending on the station you are running:

� On a server (or server with client) station, type:

nv6ððð

Then press Enter .

� On a client station, type:

nv6ððð -map myMAP

Then press Enter .

Note:  myMAP is a name you choose for the map that you are starting.

This starts the NSM.
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Accessing On-line Documentation
Access to on-line User's Guides is provided using the Netscape web browser.
Select Help → IBM Nways Switch Manager from the menu bar of the NetView
user interface. Two menu items are available:

� Alarm Description for the 2220 Nways BroadBand Switch

� Nways Switch Manager User's Guide.

Selecting either of these books open a Netscape web browser containing the
selected book.

See “Internet Connection Server Configuration” on page 13 for information on con-
figuring the web server.
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 Specific Considerations

This chapter describes various tasks concerned with running and managing your
machines:

� Adding a new Nways Switch

� Verifying TCP/IP communication

� Communicating with the support center.

Adding a New Nways Switch
When adding a new Nways Switch to your 2220 Network, it must be known by the
network management station.

Once the new Nways Switch administration station (NAS) is connected to your
network, follow these steps:

1. Define the new Nways Switch in the NSM by editing the ab_netdef.txt file as
explained in “Defining the Nways Switches (ab_netdef.txt file)” on page 14.

2. To take into account any resource changes, and refresh the topology accord-
ingly, use the Refresh Topology Network  option of the Nways Switch  menu.
For further information, refer to "Rediscovering the Topology of Your Network"
in the On-line IBM Nways Switch Manager User's Guide.

Verifying TCP/IP Communication
This section describes how to verify the connection of the RISC System/6000 to the
IP network. To verify that the server network management station is connected to
the management access Nways Switch, follow these steps:

1. Ask your network administrator for the Nways Switch administration station
(NAS) TCP/IP address of the management access Nways Switch.

2. Using the ping command, check that TCP/IP is running on the network man-
agement station.

The syntax of the command is:

ping IP_Address

For example, if the IP address to ping is 128.1.30.129, type:

ping 128.1.3ð.129

Then press Enter .

ping is a simple TCP/IP application which sends out a datagram to a specified
destination and waits for it to come back. The following message should be
displayed:
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PING 128.1.3ð.129: 56 data bytes

64 bytes from 128.1.3ð.129: icmp_seq=ð. time=7. ms

64 bytes from 128.1.3ð.129: icmp_seq=1. time=6. ms

64 bytes from 128.1.3ð.129: icmp_seq=2. time=7. ms

64 bytes from 128.1.3ð.129: icmp_seq=3. time=11. ms

64 bytes from 128.1.3ð.129: icmp_seq=4. time=6. ms

64 bytes from 128.1.3ð.129: icmp_seq=5. time=1ð. ms

64 bytes from 128.1.3ð.129: icmp_seq=6. time=6. ms

----128.1.3ð.129 PING Statistics----

7 packets transmitted, 7 packets received, ð% packet loss

round-trip (ms) min/avg/max = 6/7/11

Note:  Press Ctrl+C to stop the application.

This display means that your network management station runs TCP/IP correctly. If
all transmitted packets are lost, refer to Appendix B, Troubleshooting.

Note:  A directly attached network management station must run RIP in the
passive (listening) mode, and the routers, when used, must filter any propa-
gation of broadcast traffic.

Communicating with the Support Center
When a problem occurs in your network, the IBM support center will try to find a
solution and, if necessary, provide a fix. To speed up the availability of the fix, IBM
can connect to your network management station through a dial connection using
TCP/IP and transfer files by using the file transfer protocol (FTP) application.

If you wish to authorize IBM to connect to your network management station, you
have to define a specific network management station user. To do so, perform the
following steps from the network management station:

1. Open an aixterm window.

2. Login as root

3. Type smit and press Enter .

4. Select Security & Users .

 5. Select Users .

6. Select Add a User .

7. Enter a User NAME, a UseriD or any other parameters you want for this user.

8. Select OK to complete the procedure.

9. When the status is OK, select Exit SMIT  from the Exit pull-down menu.

You will need to give the UserID and the associated password to IBM.
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Appendix A. NSM CD ROM Image

As displayed in the CD ROM image in Table 4, the NSM package includes the
following components:

Table 4. NSM CD ROM Image

1.6.ð.4ð3ð NBBSM ALL NBBSM

Nways Switch Manager Client only for AIX NBBSM.Client.base.obj

Nways Switch Manager Client only for AIX (runtime) NBBSM.Client.tmnsf_rte.obj

Nways Switch Manager Server+Client for AIX NBBSM.base.obj

Nways Switch Manager Server+Client for AIX (runtime) NBBSM.tmnsf_rte.obj

 Copyright IBM Corp. 1996, 1998  25



  
 

26 Nways 2220 Switch Manager: Installation Guide  



  
 

 Appendix B. Troubleshooting

This appendix provides information to help you to solve problems you may
encounter while setting up, preparing, or installing NSM.

If you encounter a problem, do the following:

1. Look through this appendix to see if the problem you are experiencing is docu-
mented.

2. Perform the suggested action.

3. If your problem is not addressed in this chapter, or if it persists, contact your
IBM representative for additional assistance.
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NSM Installation Errors
This section describes the actions to take for problems that you might have during
the installation of NSM software.

When starting the Nways 2220 Switch Manager, a message, such as paging
space low, is displayed on the network management station.

Possible Cause of Error:  The paging space, which depends on the amount of RAM avail-
able on the network management station, is not sufficient.

Suggested Action:  

1. Refer to the 2220 Nways BroadBand Switch Planning Guide, GA33-0293-04 to deter-
mine if the amount of RAM memory fits the number of Nways Switches and their config-
urations.

2. Use smit to adjust the paging space if necessary.

3. If needed, type nv6ððð and press Enter  to restart the Nways 2220 Switch Manager.

OVW fields are unknown.

Possible Cause of Error:  The ovw database does not have all the field definitions.

Suggested Action:  

1. Type nv6ððð_smit clear_topology_db and press Enter  to clear the database.

2. Type nv6ððð -fields and press Enter .

3. Type ovstart and press Enter .

The NAS and the network management station cannot communicate with
each other.

Possible Cause of Error:  The local TCP/IP is not configured or the station is not con-
nected to the IP network.

Suggested Action:  

1. Check that the Ethernet cable is connected to the network socket.

2. Check the local TCP/IP configuration, using smit for the network management station
and the Nways Switch configuration application for a NAS.

The gateway node is green but one or more nodes are blue, or all nodes
are blue in the NetView for AIX window.

Possible Cause of Error:  The NetView for AIX CMIP messages are sent via the User
Datagram Protocol (UDP) instead of TCP, or they are sent to the interface of another
adapter.

Suggested Action:  

1. Find the TCP/IP address of the Ethernet adapter on the network management station.
For example:

128.1.64.253

2. To start the IP trace, type:

iptrace -a -i enð -s 128.1.64.253 -b ipfilename

Then press Enter .

3. To format the trace, type:
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ipreport ipfilename > ipfilename.rep

Then press Enter .

4. Edit the ipfilename.rep file.

� If there are no records in the file, do the following:

 a. Type:

hostname

Then press Enter  to display the host name of the network management station.
For example: ken.b1.ibm.com

 b. Type:

host ken.b1.ibm.com

Then press Enter  to display the TCP/IP address of the network management
station. For example 128.1.64.253

c. If the TCP/IP address is not correct, edit the file /etc/hosts and set the correct
value.

d. Type /usr/OV/service/reset_ci and press Enter  to set NetView for AIX for 128
addresses.

e. Type /usr/OV/install/AHAQ/browser_ors and press Enter .

f. Type /usr/OV/install/AHAQ/browser_ld_ors and press Enter .

� If there are records in the file, do the following:

 a. Type:

ovstop

Then press Enter  to stop all the NetView for AIX daemons.

 b. Type:

export CMOT_TCP_QOS="TCP"

Then press Enter  to set NetView for AIX to use only TCP/IP.

 c. Type:

ovstart

Then press Enter  to start all the NetView for AIX daemons.

d. Edit the file $HOME/.kshrc

e. Add the following statement to the file:

export CMOT_TCP_QOS=”TCP”

f. Save the file $HOME/.kshrc

One or more nodes are blue in the NetView for AIX window.

Possible Cause of Error:  The Nways 2220 Switch Manager was not able to discover all
the nodes of your network.

Suggested Action:  There are several possible causes for this problem. Perform the fol-
lowing procedures.

1. Check the ab_netdef.txt file:

a. Edit the file /usr/OV/install/AHAQ/ab_netdef.txt

The file shows certain records, for example:

128.1.64.129 nway1.mynet.inc.com

128.1.64.131 nway2.mynet.inc.com

128.1.64.143 nway3.mynet.inc.com
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where:

� 128.1.64.129 is the TCP/IP address as defined in the NCT2,

� nway1 is the NBBS node name, not the TCP/IP symbolic name,

� mynet is the NBBS network name,

� inc.com is the optional NBBS domain name.

These parameters are those defined in the NCT2.

b. Check the syntax and modify the parameters if necessary.

c. Save the file /usr/OV/install/AHAQ/ab_netdef.txt

2. Check the TCP/IP settings of the network management station:

 a. Type:

hostname

Then press Enter .

The host name is displayed, for example tom.site.ibm.com or tom.site if there is no
NBBS domain defined.

 b. Type:

host tom.site.ibm.com

Then press Enter .

The TCP/IP address is displayed, for example 128.11.22.33

c. Check that this TCP/IP address is the one defined through the NCT2. If not, perform
the following steps:

1) Edit the file /etc/hosts

The file shows certain records, for example:

9.1ðð.35.1ðð nway1.net.inc.com

128.5.21.111 nway1.net.inc.com

128.9.63.22ð nway2.net.inc.com

where:

� 9.1ðð.35.1ðð is the TCP/IP address as defined in the NCT2.

� nway1.net.inc.com is the hostname (TCP/IP symbolic name).

You cannot have two different TCP/IP addresses related to the same host name.
In the example above, you should change the host name of the second record.

2) If your installation supports the network information service (NIS), perform the
following steps:

a) Type smit NIS and press Enter .

b) Select Start/Stop Configured NIS Daemons

c) Select the client daemon ypbind  and press Enter  to stop the daemon.

3) Type /usr/OV/service/reset_ci and press Enter  to reinitialize the NetView for
AIX daemon with the correct TCP/IP address.

4) Type /usr/OV/install/AHAQ/browser_ors and press Enter .

5) Type /usr/OV/install/AHAQ/browser_ld_ors and press Enter .

6) Set the TCP/IP address used by the event forwarding discriminator (EFD) in the
node agent. For example, type:

hostid 128.11.22.33

Then press Enter .
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3. Check the NAS. The cause of the problem may be that the NAS is not answering the
discovery process.

Check the TCP/IP routes defined for the blue nodes in the NAS. In a NAS window, type:

netstat -r

Then press Enter .

Certain records should be displayed; for example:

default 172.22.2ð.1 ð ð U -l slð

172.22.2ð.2 172.22.2ð.1 ð ð U -l slð

128.1.ð.ð 128.1.ð.129 2ð 4ðð2 U -l lanð

Verify that the default is the address of the NID adapter.

4. Check that NetView for AIX uses TCP/IP.

a. Edit the file /etc/environment and add the following statements:

CMOT_TCP_QOS=”TCP”

NVMDSAPI_DB_TYPE=shlib

NVMDSAPI_DB_DIRECTORY= usr/TMN/shlib

b. Save the file /etc/environment

c. Reboot the RISC System/6000.

When you restart the NSM, NetView for AIX will restart.
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Solving Day-to-Day Operations Problems
This section describes the actions to take for problems you might have while oper-
ating the NSM.

 Function Errors
No notifications are sent from a NAS to the NSM.

Possible Cause of Error:  The TCP/IP address of the network management station is not
set correctly in the Event Forward Discriminator (EFD) object of the NAS.

Suggested Action:  

1. Type hostname and press Enter  to display the host name of the network management
station, for example ken.b1.ibm.com

 2. Type:

host ken.b1.ibm.com

Then press Enter  to display the TCP/IP address of the network management station. For
example 128.1.64.253

3. Type /usr/OV/service/reset_ci and press Enter  to set NetView for AIX for 128
addresses.

4. Type /usr/OV/install/AHAQ/browser_ors and press Enter .

5. Type /usr/OV/install/AHAQ/browser_ld_ors and press Enter .

Problems managing both NBBS and non-NBBS networks.

Possible Cause of Error:  The NetView for AIX must be set with the Ethernet address. If
not, the discovery process cannot work.

Suggested Action:  Type:

ovorsutil -d

Then press Enter .

The Ethernet address should be displayed in the ems_sieve_agent  field. If not, define a
TCP/IP route on the network management station by using the TCP/IP configuration in
smitty.

The event desk shows all alarms twice.

Possible Cause of Error:  You manually activated the alarm filters, and the topology dis-
covery process also created Event Forward Discriminator (EFD) filters.

Suggested Action:  You only need to activate EMS filters through the CMIP event desk.
For more information, refer to the on-line DynaText Nways 2220 Switch Manager User's
Guide.

The NetView for AIX window disappears without any action from the user.

Possible Cause of Error:  The paging space, which depends on the amount of RAM avail-
able on the network management station, is not sufficient.

Suggested Action:  

1. Refer to the 2220 Nways BroadBand Switch Planning Guide, GA33-0293-04 to deter-
mine if there is enough RAM memory for the number of Nways Switches and their con-
figurations.

2. Use smitty to adjust the paging space if necessary.
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3. On an aixterm window, type ovstop and press Enter  to stop the NSM.

4. Type ovstart and press Enter .

5. Type nv6ððð and press Enter  to restart the NSM.

A window “Time-out when activating filter...” is displayed when starting.

Possible Cause of Error:  The NSM was not able to create an Event Forwarding
Discriminator (EFD) filter on one or more nodes. It could be that communication with the
Nways Switch administration station (NAS) is not possible (link down, NAS rebooting, and so
on).

Suggested Action:  

Retry to create the EFD when the communication with the NAS is up again.

A Pop-up Window “Agent Connection Error” is displayed.

Possible Cause of Error:  

The ISDN application is not functional (records are not registered in the ors database).

Suggested Action:  To register records, do the following:

1. Type /usr/OV/service/reset_ci and press Enter .

2. Type /usr/OV/install/AHAQ/browser_ors and press Enter .

3. Type /usr/OV/install/AHAQ/browser_ld_ors and press Enter .

The CMIP Browser Application is not Functional

Possible Cause of Error:  Records are not registered in the ors database.

Suggested Action:  

To register records, do the following:

1. Type /usr/OV/service/reset_ci and press Enter .

2. Type /usr/OV/install/AHAQ/browser_ors and press Enter .

3. Type /usr/OV/install/AHAQ/browser_ld_ors and press Enter .

Communication Errors from NetView for AIX
If communication errors from NetView for AIX are not displayed on the network
management station, check the following files to see if any errors occurred before
you perform any of the procedures in this section:

 � /usr/OV/log/nettl.TRCð

 � /usr/OV/log/nettl.LOGð

Communication Error 1.

Possible Cause of Error:  A request is sent to a NAS association and a timer expired
before the answer is received.

Suggested Action:  

This is a transient error.

1. Check the remote application.

2. Perform the request again.
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Communication Error 6.

Possible Cause of Error:  The XMP process cannot find the destination address.

Suggested Action:  

1. Type ovorsutil -d and press Enter .

2. The display shows information used by NetView for AIX. Look for the Target host  and
Host name  fields, which indicates your host name; for example: tom.site.ibm.com.

3. If these fields are not correct, type:

host tom.site.ibm.com

Then press Enter .

4. Your host name and TCP/IP address are displayed. For example:
tom.site.ibm.com=128.11.22.33

5. If the TCP/IP address is not correct, edit the file /etc/hosts and set the correct value.

6. Type hostid 128.11.22.33 and press Enter .

7. Type /usr/OV/service/reset_ci and press Enter .

8. Type /usr/OV/install/AHAQ/browser_ors and press Enter .

9. Type /usr/OV/install/AHAQ/browser_ld_ors and press Enter .

Communication Error 21.

Possible Cause of Error:  A request sent to a NAS has failed.

Suggested Action:  

1. Use the ping command to verify the TCP/IP communication with the NAS station.

2. Check that the network management station can communicate with the NAS. To do so,
from the Network Submap select the node icon corresponding to the NAS that failed,
and select Nways Switch → TCP/IP Function . The communication is complete when
the TCP/IP Communication window is displayed.

3. Check that the Management Services Framework (MSF) stack is started on the NAS.

Communication Error 34.

Possible Cause of Error:  A request or an event report cannot be sent to a remote applica-
tion in a NAS because no association is defined.

Suggested Action:  

1. Use the ping command to verify that the network management station can communicate
with the NAS.

2. Check that the network management station can communicate with the NAS. To do so,
from the Network Submap select the node icon corresponding to the NAS that failed,
and select Nways Switch → TCP/IP Function . The communication is complete when
the TCP/IP Communication window is displayed.

3. Check that the MSF stack is started on the NAS.

4. Check that the NAS TCP/IP address is correctly defined in the network management
station. Refer to “Defining the Nways Switches (ab_netdef.txt file)” on page 14.
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 Glossary

The following are the abbreviations and technical terms
used in the 2220 Nways Switch library.

2220.  The IBM 2220 Nways BroadBand Switch (also
called Nways Switch) is a fast packet switch enabling
high-speed communications over a broadband network.
It implements the functions of the IBM Networking
BroadBand Services (NBBS) architecture.

2220-300.  2220 Nways Switch Model 300.

2220-500.  2220 Nways Switch Model 500.

2220-501.  2220 Nways Switch Model 501.

2220 NSM.  2220 Nways Switch Manager

AAL .  ATM adaptation layer.

ABR .  Availability bit rate. A best effort service with a
minimum bit rate and a maximum cell loss value.

ac.  Alternating current.

access services .  Functions that are performed by a
port adapter of the IBM 2220 Nways BroadBand Switch
to:

� Support the attachment of external user devices
through port lines

� Prepare user data packets

� Control the input traffic on port lines

� Manage line protocols.

active remote connector (ARC) .  A connector that
supplies the electrical and physical interfaces between a
line interface coupler type 511 (LIC511) in an Nways
Switch subrack and data circuit-terminating equipment
(DCE) or data terminal equipment (DTE). ARCs are
housed in line connection boxes (LCBs).

adapter .  An Nways Switch module that can be used,
depending on its hardware type and the code that it
runs, as:

Control point adapter

 Port adapter

 Trunk adapter

Voice server adapter.

A trunk or port adapter is associated with a line inter-
face coupler (LIC). A voice server adapter can be
associated with a voice server extension (VSE).

ADPCM.  Adaptive differential pulse code modulation.

AIS.  Alarm indicator signal.

AIX.  Advanced Interactive Executive.

alarm and power control (APC) .  In an Nways Switch,
a module that connects the NAS, reports alarms, and
controls the power supplies.

Alert Manager .  An application that processes the SNA
alerts received from IBM 3746s operating in IP mode.

AMI.  Alternate mark inversion.

ANSI.  American National Standards Institute.

APC.  Alarm and power control (module).

AR.  Access rate.

ARC.  Active remote connector.

asynchronous transfer mode (ATM) .  A high-speed,
connection-oriented switching and multiplexing protocol
that transmits different types of traffic (voice, video, and
data) simultaneously.

ATM.  Asynchronous transfer mode.

ATMAn .  ATM adapter type n (module).

ATM adaptation layer (AAL) .  In ATM devices, a set
of protocols that adapt non-ATM devices to an ATM
network. There are several classes of ATM adaptation
layers which represent the main traffic types (for
example, data, voice, and video).

ATM network interface .  A logical resource generated
by the Nways Switch Control Program to provide
access services to a physical ATM port or trunk line. An
ATM network interface sets up and maintains prede-
fined ATM virtual connections.

AT&T .  American Telephone & Telegraph (Company).

B8ZS.  Bipolar eight-zero substitution.

Bc .  Burst committed.

Be.  Burst in excess.

bearer service profile (BSP) .  A set of parameters that
defines a type of ISDN traffic (speech, audio, data, or
video). One BSP is associated with each ISDN num-
bering plan table.

BECN.  Backward explicit congestion notification.

B-ICI.  Broadband inter-carrier interface.
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BMI.  Byte multiplexer interface.

BNC.  Bayonet Niell-Concelman.

bps .  Bit per second.

bridge .  A functional unit that interconnects two local
area networks. A bridge works at the data link level
(layer 2) of the OSI reference model.

broadband network .  A network that uses a large fre-
quency band to transport different kinds of traffic (such
as coded voice, video, and data) at the same time.

BS.  Bearer services.

BSC.  Binary synchronous communication.

BSP.  Bearer service profile.

BT.  Burst tolerance.

bursty .  Refers to transmission at variable bit rate
where the time between data transmissions is not
always the same.

CAC.  Connection admission control.

CAS.  Channel associated signaling.

CBR.  Constant bit rate.

CCS.  (1) Common channel signaling (2) Change
control server (also called CC server).

CDB.  Configuration database.

CDV.  Cell delay variation.

CDVT.  Cell delay variation tolerance.

cell loss priority (CLP) .  A priority bit in the ATM cell
header. When set, it indicates that the cell can be dis-
carded during traffic congestion.

centralized configuration database .  A database pre-
pared with the Nways Switch Configuration Tool Version
2 (NCT2) on a configuration station. It stores the param-
eters of a 2220 network.

CES.  Circuit emulation services.

change control server (CCS or CC server) .  A station
that runs the IBM NetView Distribution Manager for AIX
to store the Nways Switch Control Program and to
manage code changes.

CIR.  Committed information rate.

circuit emulation services (CES) .  An access service
that emulates a leased line. It transports information

with a constant bit rate at the source and destination.
The traffic can be PCM voice, video, fax, multimedia, or
real-time synchronous data (such as BSC).

CLIP.  Calling line identification presentation.

CLIR.  Calling line identification restriction.

CLK .  Clock (module).

CLKRD .  Clock redrive (module).

clock module (CLK) .  A module of the 2220 Model
300 or 500 that transmits clock signals to the line inter-
face couplers (LICs). It is optional and can have a
backup.

clock redrive (CLKRD) .  A module of the 2220 Model
501 that drives the signals from the Model 500 clock
module to the adapters of the Model 501. The clock
redrive is optional and can have a backup.

clock references .  In an Nways Switch, the software
function that controls the transmission of clock signals
to the LICs where they are used for bit synchronization.

CLP.  Cell loss priority.

CMIP.  Common management information protocol.

CMIS.  Common management information services.

CMOT.  CMIP over TCP/IP.

CNM.  Communication network management.

code file .  A named set of records stored as a unit in a
change control server. An Nways Switch code file can
include data or internal code.

COLP.  Connected line identification presentation.

COLR.  Connected line identification restriction.

configuration station .  See Nways Switch configura-
tion station.

control point (CP) .  In an Nways Switch, a logical
resource that provides network control functions. It can
have a backup.

CP.  Control point.

CPA.  Control point adapter (module).

CPE.  Customer premises equipment.

CP spanning tree .  In a 2220 network, a distribution
tree that connects the Nways Switch control points
through trunk lines.
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The CP spanning tree supplies a very fast and efficient
way to multicast control messages such as network
topology data.

CRC.  Cyclic redundancy check.

CSU.  Channel access unit.

CTD.  Cell transfer delay.

data circuit-terminating equipment (DCE) .  An equip-
ment installed on a user premises that provides all the
functions required to establish, maintain, and terminate
a connection, and to do the signal conversion and
coding between a data terminal equipment (DTE) and a
line. A DCE can be separate piece of equipment or part
of other equipment.

data terminal equipment (DTE) .  That part of a data
station that serves as data source, data sink, or both,
and provides the data communication control function
depending on the type of protocol used.

dB . Decibel.

dBm .  Decibel based on 1 milliwatt.

DC48.  Dc power input type -48V

dc .  Direct current.

DCD.  Dc distribution (module).

DCE.  Data circuit-terminating equipment.

DDI.  Direct dialing-in.

DE.  Discard eligibility.

decibel (dB) .  (1) One tenth of a bel. (2) A unit that
expresses the ratio of two power levels on a logarithmic
scale. (3) A unit for measuring relative power. The
number of decibels is 10 times the logarithm (base 10)
of the ratio of the measured power levels; if the meas-
ured levels are voltages (across the same or equal
resistance), the number of decibels is 20 times the log
of the ratio.

decibel based on 1 milliwatt (dBm) .  A unit of abso-
lute power measurement that is scaled such that 0 dBm
equals 1 milliwatt.

dialog box .  On the screen of a station, an area with
entry fields and push buttons. (Also called dialog.)

DLCI.  Data link connection identifier.

DNPT.  Destination numbering plan table.

DSP.  Digital service processor.

DSU.  Data service unit.

DTE.  Data terminal equipment.

DTMF.  Dual-tone modulation frequency.

DTR.  Data terminal ready.

dummy module .  In an Nways Switch, a cover inserted
in the place of a module to ensure correct air cooling
inside a logic subrack. During normal operation, the
dummy modules must not be removed.

E1 standard .  A European standard for TDM digital
transmission service at 2.048 Mbps.

E3 standard .  A European standard for TDM digital
transmission service at 34.368 Mbps. An E3 line can
transport up to 16 E1 circuits.

E&M.  Earth & mark.

ECMA.  European Computers Manufacturers Associ-
ation.

EIA.  Electronics Industries Association.

equivalent capacity .  The minimum amount of band-
width needed by a connection to ensure that the packet
loss ratio is below a specified threshold.

ESF.  Extended status flags.

ETS.  European telecommunication standard.

FANB .  Fan box.

FAT.  File allocation table.

fax .  Document received from a facsimile machine.
Synonym for telecopy.

FCS.  Frame check sequence.

FDDI.  Fiber Distributed Data Interface.

FE1.  Fractional E1.

FECN.  Forward explicit congestion notification.

FEP.  Front-end processor.

fiber .  Synonym for optical fiber.

fiber budget .  The optical power loss as result of the
number of connections in the optical fiber link sub-
tracted from the working budget. The loss as a result of
connections includes connector loss and splice loss.
The fiber budget is expressed in decibels.

Fiber Distributed Data Interface (FDDI) .  A U.S.
standard for 100 Mbps token-ring LANs using optical
fiber cables over distances of several kilometers.
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fiber optic cable .  Synonym for optical fiber.

FR.  Frame relay.

FRAD.  Frame-relay access device.

frame relay (FR) .  A connection-oriented protocol to
transport data frames over a fast packet-network with
guaranteed end-to-end quality of service.

FRFH.  Frame-relay frame handler.

front-end processor (FEP) .  A processor, such as the
IBM 3745, 3746 Model 900 or 950, or 3174, that
relieves a main frame from communication control
tasks.

FRTE.  Frame-relay terminal equipment.

FRU.  Field replaceable unit.

FT1.  Fractional T1.

FTP.  File transfer protocol.

Gbps .  Gigabit per second (10 to the power of 9 bits
per second).

GCRA.  Generic cell rate algorithm.

GFP.  Generic function protocol.

GFT.  Generic function transport.

GSM.  Group special mobile.

GUI.  Graphical user interface.

HDB3.  High-density bipolar 3.

HDLC.  High-level data link control.

high-level data link control (HDLC) .  A data network
protocol.

hot pluggable .  Refers to a hardware component that
can be installed or removed without disturbing the oper-
ation of any other resource that is not connected to, or
dependent, on this component.

HPFS.  High-performance file system.

HPRI.  High priority.

HSAn .  High-speed adapter type n (module).

HSDS.  High-speed digital services.

HSSI.  High-speed serial interface.

hub (intelligent) .  A wiring concentrator, such as the
IBM 8260, that supplies bridging and routing functions
for LANs with different cables and protocols.

hunt group .  See X.25 hunt group.

IDNX.  Integrated Digital Network Exchange.

IE.  Information element.

ILMI.  Interim local management interface.

IMU.  Inverse multiplexing unit

Integrated Digital Network Exchange (IDNX) .  A
processor integrating voice, data, and image applica-
tions. It also manages transmission resources and con-
nects to multiplexers and network management support
systems. It permits integration of equipment from dif-
ferent vendors.

integrated services digital network (ISDN) .  A digital
end-to-end public or private network that supports mul-
tiple services including, but not limited to, voice and
data.

IP.  Internet Protocol.

IP gateway adapter .  In an Nways Switch, a port
adapter that routes the IP control between the NAS and
the network management station.

ISDN.  Integrated services digital network.

ISDN network interface .  A logical resource generated
by the Nways Switch Control Program to provide
access services to a physical ISDN or QSIG port line.
An ISDN network interface sets up and maintains con-
nections between calling ISDN terminal equipments and
called terminal equipments attached through other
Nways Switches.

ISO.  International Organization for Standardization.

isochronous .  Refers to transmission at a constant bit
rate where there is a clock relationship between source
and destination. The bit rates are the same on the des-
tination and source.

ITU-T.  International Telecommunication Union - Tele-
communication (replaces CCITT).

jitter .  Undesirable variations in the transmission delay
of a digital signal. Also called cell delay variation (CDV).

KB .  Kilobyte (storage capacity, 1024 bytes).

kbps .  Kilobit per second (1000 bits per second).

LAN .  Local area network.
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LAPB .  Link access procedure for B-channel.

LAPD .  Link access procedure for D-channel.

LCB .  Line connection box.

LCBB .  Line connection box, base (LCEB and LCPB).

LCBE .  Line connection box, expansion (LCEE and
LCPE).

LCEB .  Line connection enclosure, base.

LCEE.  Line connection enclosure, expansion.

LCPB .  Line connection power, base.

LCPE.  Line connection power, expansion.

LCR.  Least cost routing.

LED.  Light-emitting diode.

LICn .  Line interface coupler type n (module).

line .  In a 2220 network, any physical medium, such as
a telephone wire, microwave beam, or optical fiber, that
transmits information. A line can be a trunk line or a
port line.

line connection box (LCB) .  A metallic box that:

� Multiplexes up to 15 low-speed lines. There can be
up to four LCBs per LIC type 511 for a total of 60
lines (two LCBs and 30 lines per LIC connector).

� Reduces cable lengths between Nways Switch and
DCE or DTE locations.

An LCB fits in a standard 19-inch rack. Each one
houses up to 15 active remote connectors (ARCs).

line interface coupler (LIC) .  In an Nways Switch, a
module that physically attaches trunk or port lines.
Each line interface coupler is associated with a trunk or
port adapter, and supports specific line interfaces.

LIV.  Link integrity verification.

LMI.  Local management interface.

local area network (LAN) .  A computer network
located on a user premises in a limited geographical
area.

logical port .  (Also called NBBS port.) A logical
resource generated by the Nways Switch Control
Program to provide access services to a physical port
line (or channel of a TDM port line) using HDLC, FR, or
CES protocol. A logical port sets up and maintains its
predefined connections.

logical trunk .  (Also called NBBS trunk.) A logical
resource generated by the Nways Switch Control
Program to provide transport services to a physical
trunk line (or channel of a TDM trunk line). A logical
trunk is mainly responsible for optimizing bandwidth and
maintaining the CP spanning tree.

LSAn .  Low-speed adapter type n (module).

MA/SR. Multi-access/sub-rate.

management access .  Refers to an Nways Switch that
connects a network management station or a change
control server to a 2220 network through its service
bus, which is a dedicated Ethernet LAN.

MB.  Megabyte (storage capacity, 1 048 576 bytes).

Mbps .  Megabit per second (10 to the power of 6 bits
per second).

MBS.  Maximum burst size.

MLT.  Multiple logical trunks.

module .  In an Nways Switch, a hardware unit plugged
in a slot of the logic subrack. It houses, for example, an
adapter, a line interface coupler, or a voice server
extension. All modules are hot pluggable.

ms .  Millisecond (1/1000 second).

NAS.  Nways Switch administration station.

NBBS .  Networking BroadBand Services (architecture).

NBBS architecture .  See Networking BroadBand Ser-
vices.

NBBS connection .  See potential connection and
virtual connection.

NBBS network .  A network built with IBM 2220 Nways
BroadBand Switches and conforming to the IBM Net-
working BroadBand Services (NBBS) architecture.

NBBS port .  See logical port.

NBBS trunk .  See logical trunk.

NCT2.  Nways Switch Configuration Tool Version 2.

NDPS.  Non-disruptive path switching.

NEM.  Nways Enterprise Manager (see 2220 Nways
Switch Manager).

network control .  Functions that are performed by an
Nways Switch control point to:

� Allocate and control the Nways Switch resources

� Provide topology and directory services
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 � Select routes

 � Control congestion.

network management station (NMS) .  A station that
runs IBM NetView for AIX and the 2220 Nways Switch
Manager. It is used to manage network topology,
accounting, performance, configuration, and error
reporting.

network node interface (NNI) .  An interface between
nodes in a communication network.

Network Support Center (NSC) .  A location from
which IBM remotely supports 2220 networks.

Networking BroadBand Services (NBBS) .  An IBM
architecture for high-speed networking that comple-
ments ATM standards and provides access services,
transport services, and network control to user traffic.

NIC.  Network Information Center.

NMS.  Network management station.

NNI.  Network node interface.

NPT.  Numbering plan table.

NR. Non-reserved.

NRT. Non-real-time.

NRZI.  Non-return-to-zero inverted recording.

NRZ-1.  Non-return-to-zero change-on-ones recording.

NSAP.  Network service address point.

NSC.  Network Support Center.

NSM.  (See 2220 Nways Switch Manager)

NVDM.  NetView Distribution Manager for AIX.

NTT.  Nippon Telegraph & Telephone (Corporation).

numbering plan table (NPT) .  A set of parameters,
organized in origin NPT and destination NPT, that
defines a type of called ISDN numbers. A numbering
plan table is associated with each ISDN network inter-
face.

Nways 2220 Switch Manager (2220 Switch
Manager) .  An IBM licensed program that runs under
NetView for AIX to manage the 2220 Nways Switch
operation and configuration from a network manage-
ment station. It replaces the Nways Enterprise Manager
(NEM) which is no longer available.

Nways BroadBand Switch .  Synonym for 2220 Nways
BroadBand Switch.

Nways Enterprise Manager (NEM) .  An IBM licensed
program that was used under NetView for AIX in a
network management station to manage Nways
Switches, routers, and bridges in a 2220 network (see
2220 Nways Switch Manager).

Nways Switch .  Synonym for 2220 Nways BroadBand
Switch.

Nways Switch administration station (NAS) .  A
station attached to each 2220 to run the Control
Program, and control and service the Nways Switch
locally.

Nways Switch configuration station .  A mandatory
OS/2 or AIX station that runs a stand-alone version of
the Nways Switch Configuration Tool Version 2 (NCT2)
and stores the centralized configuration database of the
NBBS network. An OS/2 station can be used as a
remote user console.

Nways Switch Configuration Tool Version 2
(NCT2).  A component of the Nways Switch Control
Program that is used to configure physical and logical
resources. It is also used in stand-alone version under
OS/2 or AIX .

Nways Switch Control Program .  The IBM licensed
program that runs in the NAS and adapters of the 2220
Nways Switch. It includes a CMIP agent to work with
the 2220 Switch Manager.

Nways 2220 Switch Manager for AIX .  (See Nways
2220 Switch Manager)

Nways Switch Resource Control .  A component of
the Nways Switch Control Program. It is used from the
NAS of an Nways Switch or from a remote user console
to control resources and configuration files.

OAM.  Operation, administration, and maintenance.

OC3.  Optical carrier level 3.

ONPT.  Origin numbering plan table.

operation, administration, and maintenance (OAM) .
A group of functions coded in specific ATM cells to
handle alarms and loopback tests on ATM connections.

optical fiber .  In fiber optics technology, a wave guide
that propagates optical signals from light-generating
transmitters to light-detecting receivers.

OSI.  Open systems interconnection.

packet loss ratio .  The probability that a packet will
not reach its destination or not reach it in a specified
time. It is obtained by dividing the number of packets
lost in transmission by the total number transmitted.
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packet transfer mode (PTM) .  The native transfer
mode of the NBBS architecture. PTM divides the traffic
into packets of variable length.

PBX.  Private branch exchange.

PCM.  Pulse code modulation.

PCR.  Peak cell rate.

PDH.  Plesiochronous digital hierarchy.

permanent virtual circuit (PVC) .  A virtual circuit that
has a logical channel permanently assigned to it at
each item of data terminal equipment. It is activated by
a program or by a network operator request.

plesiochronous .  Refers to transmission at a nominal
bit rate where the source and destination are controlled
by different clocks. The bit rates are nearly the same.

PLP.  Packet layer protocol.

PNP.  Private numbering plan.

port .  See logical port.

port adapter .  In an Nways Switch, a module that pro-
vides access services to one or more port lines. Each
port adapter is associated with a line interface coupler
(LIC).

port line .  A communication line that connects a device
on user premises to an Nways Switch and serves as a
port to the 2220 network. Port lines have different proto-
cols and interfaces.

position .  When configuring an Nways Switch, the
position parameter indicates the line attachment number
on the LIC module (1 to 8, depending on the LIC type).

potential connection .  A predefined connection
through a 2220 network between two HDLC, CES, or
frame-relay devices.

PPP.  Point-to-point protocol.

PRA.  Primary Rate Access.

private branch exchange (PBX) .  A switching system
located on a user premises that relays inside lines
(extensions) and provides access to the public tele-
phone network.

PRS.  Primary reference source.

PSDN.  Packet switched data network.

PSN.  Public switched network.

PSTN.  Public switched telephone network.

PTF.  Program temporary fix.

PTM.  Packet transfer mode.

PTNX.  Private telecommunications network exchange.

pulse code modulation (PCM) .  A standard adopted
for the digitalization of analog voice signals. In PCM,
voice is sampled at a rate of 8 kHz and each sample is
coded in an 8-bit frame.

PVC.  Permanent virtual circuit.

Q signaling (QSIG) .  An international standard for sig-
naling procedures in private telecommunication net-
works. It applies to the PBX-to-Nways Switch interface,
which is called the Q reference point.

QoS.  Quality of service.

QSIG.  Q signaling.

quality of service (QoS) .  In a 2220 network, a set of
parameters that guarantees the characteristics of a con-
nection, mainly its end-to-end delay, delay variation,
and packet loss tolerance.

RABM .  Router and Bridge Manager.

rack .  A metallic structure, with a standard 19-inch
width, that houses the hardware elements of an Nways
Switch, that is, logic subrack with modules, fan boxes,
and power units.

When configuring an Nways Switch, the rack parameter
indicates the 2220 Model (rack A is the Model 300 or
500, and rack B is the Model 501).

RDI.  Remote defect indication.

real-time processing .  Refers to the manipulations of
data that are required, or generated, by certain process
while the process is in operation. Usually, the results
influence the process and, perhaps, related processes.

remote user console .  A station running OS/2,
TCP/IP, and Nways Switch Resource Control. It can be
connected to the NAS of an Nways Switch to remotely
control and service it.

resource .  In an Nways Switch, a hardware element or
a logical entity created by the Control Program.
Adapters, modules, and line attachments are examples
of physical resources. Control points, logical trunks,
logical ports, and network interfaces are examples of
logical resources.

resource profile .  A record of the characteristics of an
Nways Switch resource. It includes (for example) the
part number or module name, the change level, and the
name and phone number of the person to contact when
a problem occurs.
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RETAIN.  Remote Technical Assistance Information
Network

RIP.  Route Information Protocol.

router .  An attaching device that connects two LAN
segments of the same or different architectures. It can
also be connected to a wide area network. A router
works at the network level (layer 3) of the OSI reference
model by determining the best paths for network traffic
flows.

Router And Bridge Manager .  An application that pro-
vides distributed management for routers such as the
IBM 2210 or 2216, bridges such as the IBM 8229, and
communication controllers such as the IBM 3746 in IP
mode.

RS.  Recommended specification.

RSF.  Remote support facility.

RSN.  Receive sequence number.

RT. Real-time.

RVX.  RS/EIA-232, V.24/V.35, X.21.

s. Second.

SCR.  Sustainable cell rate.

SDH.  Synchronous digital hierarchy.

SDLC.  Synchronous data link control.

SDT.  Structured data transfer.

serial line internet protocol (SLIP) .  A TCP/IP pro-
tocol used on a point-to-point connection between two
IP hosts over a serial line (for example, an RS/EIA-232
connection to a modem over a telephone line).

SLA .  Serial link architecture.

SLIP.  Serial line internet protocol.

slot .  When configuring an Nways Switch, the slot
parameter indicates the module location (1 to 12) in the
logic subrack.

SNA.  Systems Network Architecture.

SNMP.  Simple Network Management Protocol.

SONET.  Synchronous optical network.

spanning tree .  See CP spanning tree.

SRC.  System reference code.

SSN.  Send sequence number.

station .  A microcomputer that is connected to a host
or a network and at which a user can run applications.

STM-1.  Synchronous transport module type 1.

STS-3c.  Synchronous transport signal type 3 concat-
enated.

SUB. Subaddress.

subrack .  A metallic structure installed in an Nways
Switch rack. A logic subrack holds modules. A power
subrack holds power supply components.

SVC.  Switched virtual circuit.

SW.  Switch (module).

switch module (SW) .  A module of the 2220 Model
300 or 500 that interconnects the adapters through an
ATM cell switch. It can have a backup.

switch redrive (SWRD) .  A module of the 2220 Model
501 that drives the signals from the switch module in
the Model 500 to the adapters of the Model 501. It can
have a backup.

SWRD.  switch redrive (module)

switched virtual circuit (SVC) .  A connection set up
from a calling address to a called address following a
call establishment protocol. It is released when a clear
request signal is received.

synchronous digital hierarchy (SDH) .  A international
recommendation for the internal operation of carrier
optical networks.

synchronous optical network (SONET) .  A U.S.
standard for transmitting digital information over optical
interfaces. It is closely related to the international
recommendation for synchronous digital hierarchy
(SDH).

T1 standard .  A TDM digital transmission service with
a basic rate of 1.544 Mbps. Also called DS-1.

T3 standard .  A TDM digital transmission service with
a basic rate of 44.736 Mbps. A T3 line can transport up
to 28 T1 circuits. Also called DS-3.

TCPA.  Trunk and control point adapter.

TCP/IP.  Transmission Control Protocol/ Internet Pro-
tocol.

TDM.  Time division multiplexing.

TE.  Terminal equipment.
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Telnet .  In TCP/IP, an application protocol that allows a
user at one site to access a remote system as if the
display station were locally attached. Telnet uses the
Transmission Control Protocol (TCP) as the underlying
protocol.

time division multiplexing (TDM) .  The process of
breaking the bandwidth on a communication line into a
number of channels, possibly of different size.

TME.  Tivoli Management Environment.

TMN.  Telecommunication Management Network.

TPA.  Trunk or port adapter.

Transmission Control Protocol/ Internet Protocol
(TCP/IP).  A set of communication protocols that
support peer-to-peer connections over both local and
wide area networks.

transport services .  Functions that are performed by a
trunk adapter of an Nways Switch to:

� Support the attachment of trunk lines

� Maximize bandwidth utilization

� Guarantee the quality of service of a connection

� Transfer packets between Nways Switches

� Manage logical queues and schedule transmission.

trunk .  See logical trunk.

trunk adapter .  In an Nways Switch, a module that
provides transport services to one or more trunk lines.
Each trunk adapter is associated with a line interface
coupler (LIC).

trunk line .  In a 2220 network, a high-speed line con-
necting two Nways Switches. It can be, for example, a
copper cable, optical fiber, or radio wave guide and can
be leased from telecommunication companies.

UBR.  Unspecified bit rate. A best effort service with no
quality commitment.

UNI.  User network interface.

UPC.  Usage parameter control.

URL.  Uniform resource locator.

user network interface (UNI) .  A standardized inter-
face between a user and a communication network.

UTC.  Universal time, coordinated.

UUS.  User-user signaling.

VBR.  Variable bit rate.

VC.  Virtual channel.

VCC.  Virtual channel connection.

VCI.  Virtual channel identifier.

VCN.  Virtual circuit number.

virtual channel (VC) .  In ATM, a unidirectional route
between two ATM devices. Virtual channels always
come in pairs, one in each direction. They follow virtual
paths.

virtual channel connection (VCC) .  In ATM, a
unidirectional connection established over a virtual
channel. Virtual channel connections always come in
pairs, one VCC in each direction.

virtual channel identifier (VCI) .  In ATM, the unique
numeric tag that identifies every channel. It is defined
by a 16-bit field in the ATM cell header.

virtual connection .  In frame relay, the return path of
an FR potential connection.

virtual path (VP) .  In ATM, a group of virtual channels
that are switched together as one unit. (Also called VC
service.)

virtual path connection (VPC) .  In ATM, a connection
established over a virtual path. Virtual path connections
always come in pairs, one VPC in each direction. (Also
called VP service.)

virtual path identifier (VPI) .  In ATM, an 8-bit field in
the ATM cell header that indicates the virtual path over
which the cell is to be routed.

voice server adapter (VSA) .  In an Nways Switch, a
module that supplies additional voice functions to voice
connections operating in pulse code modulation at
64 kbps. It can attach a voice server extension (VSE).

voice server extension (VSE) .  In an Nways Switch, a
module associated with a voice server adapter (VSA) to
supply voice functions to an extended number of PCM
voice connections.

VP.  Virtual path.

VPC.  Virtual path connection.

VPD.  Vital product data.

VPI.  Virtual path identifier.

VPN.  Virtual private network.

VSA.  Voice server adapter (module).

VSEn.  Voice server extension type n (module).
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WAN.  Wide area network.

wide area network (WAN) .  A network that provides
communication services to a large geographic area. It
can use or provide public communication facilities.

window .  On the screen of a station, an area with a
title bar, a menu bar, and scroll bars.

X.25 hunt group .  A group of X.25 network interfaces
associated with one common subscriber address. If an
interface is busy, the connection searches (hunts) for
the other interfaces of the group until a free one is
found.

X.25 network interface .  A logical resource generated
by the Nways Switch Control Program to provide
access services to a physical X.25 port line. An X.25
network interface sets up and maintains connections
between calling X.25 subscribers and called subscribers
attached to other Nways Switches.

X.25 Recommendation .  An international standard for
the interface between data terminal equipments and
packet-switched networks.

X.25 subscriber .  An X.25 end-user connected to an
X.25 network interface through a DTE. A subscriber is
defined by an address and a logical name.
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